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The purpose of this guide is to provide you with the basic steps to making data 

throughput measurements with your E6621A PXT. 

Your test set will help you meet your stringent time-to-market schedules and 

design quality goals. From protocol development through RF conformance and 

interoperability testing, the PXT is a powerful, scalable user equipment (UE) 

test platform. The advanced capabilities of the PXT include real-time, system-

rate network and base station emulation. The test set also provides bench-top 

network emulation for quick and easy UE application and performance testing. 

Downlink MIMO, RF measurements and end-to-end IP data connections are just 

a few of the many features that will make your UE development process more 

efficient and successful.  

Figure 1. Agilent E6621A PXT Wireless Communications Test Set

General capabilities of the Agilent E6621A PXT

• Real-time 3GPP LTE downlink (DL) signal modulation

• Real-time 3GPP LTE uplink (UL) demodulation

• eNodeB simulation with L1, L2 and L3 protocol stack

• Settable eNodeB, UE, and network operation parameters

• Settable frequency, power and modulation schemes

• MIMO testing capabilities

• 3GPP LTE UE testing with call-setup and loop-back mode using data transfer

 and PER measurement

• Spectrum measurements with adjustable frequency, span, channel bandwidth,

 and resolution bandwidth

• Power versus time

• 3GPP LTE RF and modulation measurements

• Sub-carrier power flatness

• 3GPP LTE UE L1, L2 and L3 layer verification and performance tests, including

 power control and measurements, handovers, and abnormal test cases. 

1.  Introduction
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Additional Applications

The following PC application software is available to enhance the capabilities of 

the Agilent PXT.

Agilent N6061A Protocol Logging and Analysis Tool

This application software is developed for use on systems running the Microsoft 

(MS) Windows XP or Windows 7 operating system. It displays and stores proto-

col and event logs of Agilent E6621A PXT. The stored log files can be replayed 

and analyzed using this software and other advanced post-processing tools. 

Please consult the “Agilent LTE Protocol Logging and Analysis User’s Guide” for 

more information.

Agilent N6062A Protocol Message Editor Tool

This application software is developed for use on systems running the MS 

Windows XP or Windows 7 operating system. N6062A provides the ability to 

define RRC/NAS messages and event-driven scenarios which can be utilized 

during the Base Station Emulator (BSE) operating mode of the Agilent E6621A 

PXT.. Please consult the “Agilent LTE Message Editor User’s Guide” for more 

information.

Agilent N6070A Series Signaling Conformance Test System 

The N6070A series signaling conformance test system verifies the protocol 

characteristics of LTE UEs. It provides a standards-based and flexible develop-

ment environment for the LTE protocol stack development, regression test, 

pre-conformance and conformance.  The system uses the Agilent E6621A PXT 

with TTCNv3 test scripts released from ETSI. Please consult the “Agilent N6070 

Series Signaling Conformance Test User’s Guide” for more information.

Anti-Virus Protection and Firewalls

The PXT is shipped with the Windows XP firewall enabled. No anti-virus soft-

ware is shipped with the instrument. It is recommended that you do not install 

anti-virus protection. 

WARNING: Take care to verify that USB memory devices used with the Agilent 

E6621A PXT are virus-free before use with the instrument.

Software Licensing

The following third-party software is used in the examples in this Note. Other 

software with similar functionality may be available. The use of these particular 

software tools does not constitute an endorsement by Agilent Technologies. 

Software licensing, where required, is the responsibility of the user. 

Brekeke SIP Server

CounterPath X-lite

FileZilla

Iperf

VideoLAN VLC
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2.  Setting Up the Equipment
To ensure you have the required options and licenses to begin using Agilent 

E6621A PXT, see the PXT Getting Started Guide, and for more detailed user 

information, see the PXT Users Guide. The latest versions are available at 

www.agilent.com/find/pxt  

Equipment list

• E6621A PXT with appropriate options and current software technical support

 contract

• Application Server PC for data throughput testing applications

• Optional PC for N6061A Protocol Logging and Analysis and N6062A

 Message Editor software applications

• Optional UE client PC, depending on test requirements

• USB License keys for software applications

• Ethernet cables and hub as required

• Cables to attach device under test
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Setting network addresses 

To set the Network setting of the PXT. press the front panel Config button, and 

select Network Setup. The default is set as shown below. If change is needed, 

set each address and press OK to complete the change

• IP address to 192.168.1.60

• Subnet Mask 255.255.255.0

• Gateway  192.168.1.230

Figure 3. PXT Network Setting

App Server PC PXT 
Logging and 
analysis PC

IP 192.168.1.230 192.168.1.60 192.168.1.135 

Subnet Mask 255.255.255.0 255.255.255.0 255.255.255.0 

Gateway 192.168.1.60 192.168.1.230 192.168.1.60 

Table 1. The recommended network settings for the computers are shown above.
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NOTES:

1. Connecting the instrument to a LAN with internet connectivity is not 

recommended. 

2. The instrument and connected PCs operate using fixed IP addresses.

3. If the UE requires a client PC, it will normally be connected via USB. The 

UE’s IP address is assigned (DHCP) by the PXT, and is set in the Scenario 

File. The default address used in this Note is 192.168.1.51. For detailed 

instructions on setting and changing the client IP address, see the latest 

version of the Message Editor User’s Guide at www.agilent.com/find/pxt. 

See the UE documentation for connection details and operating information. 

The client PC should not be connected to the same LAN as the other equip-

ment except through the UE.

4. On both the Application Server PC and the UE client PC, turn off Windows 

Firewall to ensure communications between them are not blocked. Select 

“Control Panel”, “Administrative Tools”, “Services” and scroll to the 

Windows Firewall entry. Right click, select “Properties”, set the Startup 

Type to “Disabled” and stop the service. 

 Figure 4. Disable Windows Firewall Service

5. The N6061A Protocol Logging and Analysis software and N6062A Message 

Editor software may be installed on the same PC. It is recommended that 

no other applications are running on this PC to ensure real-time logging is 

not compromised.
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3.  Connecting the UE
The UE under test is normally connected to the PXT via the RF I/O interfaces. 

The UE can also be connected using baseband I/O interface at the rear panel 

with BNC cables. The connection configuration will depend on the required test 

setup.

Single Input Single Output (SISO)

Connect the UE antenna directly to the RF1 Input / Output connector. If the UE 

has receive diversity antennas, connect both to RF1 Input / Output via a power 

combiner.

Downlink Transmit Diversity and Multiple Input Single Output (MISO)

Connect RF1 Input / Output and RF2 Output to the UE via a power combiner.

Downlink Multiple Input Multiple Output (MIMO)

Connect RF1 Input / Output to the UE primary receive antenna.  Connect RF 2 

Output to the UE secondary receive antenna.
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4.  Setting Up a Data Connection
Follow these steps on the PXT to set up a connection to the UE.

1. Press PRESET, Preset to return the instrument to its power-on state.

2. Press FREQ and set the uplink and downlink frequencies to match your  device.

3. Press BSE, MODE SETUP, MORE 2/2, Phy Setup, and set the CFI to 1.

4. Press CONFIG, Network Setup, IP Setup and check that the IP address,  

 subnet mask and gateway are correctly set as detailed in Section 3. Press  

 OK to confirm any changes.

5. Press BSE, MODE SETUP and set EPC (Evolved Packet Core) to Embed.  

 Ensure the EPC block in the upper right of the main display is illuminated.

6. Load the Scenario File that matches the attributes of your device. Press  

 BSE, MODE SETUP, Call Scenario, choose the file you need from the list  

 and press Load  For details of creating and modifying scenario files and  

 downloading them to the PXT, see the Agilent N6062A Message Editor  

 User’s Guide. The latest version is available for download from 

 www.agilent.com/find/pxt. When the file is loaded, the filename will appear  

 in the “Base Station Emulator Information” section of the display.

7. Press BSE, MODE and set the Emulator Mode to Run.

8. On the UE, or UE client control interface PC, initiate the connection. On the  

 PXT screen, you can see the protocol message exchange between the BSE  

 and UE as the connection is authenticated and established, and the CON  

 icon in the BSE status block illuminates when the connection is complete.

9. Check that the EPC indicator in the status panel is on (solid yellow background).

10. On the UE Client PC, open a command window and enter “ipconfig” to  

 check the assigned IP address. The default used in this note is 192.168.1.51.   

 

 Figure 5. Check the UE IP address

11. To check that a data connection exists from the UE client to the application

 server , enter “ping 192.168.1.230” and check the responses from the  

 Application Server PC

12. Repeat step 11 in the reverse direction. On the Application Server, open a   

 command window, enter “ping 192.168.1.51” and check the responses from the UE.

 Figure 6. Ping result
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5.  Data Throughput Tests 
Downlink and uplink throughput tests

Before running these tests, locate, download and install the freeware server 

application “Iperf” on both the application server and UE client PCs.

Downlink throughput test

1. On the PXT, set the BSE, MODE SETUP, MORE 2/2, Phy Settings, 
DL Resource Allocation configuration to Resource Allocation Mode  
Auto, and set the I_MCS and RB Size to match your application test 
requirements. 

NOTE: When the scenario file specifies MIMO (tm3), set the resource 
allocation using the Type0 Bitmap characteristics instead of RB Size. 
See 3GPP standard 36.213 section 7.1 and 36.306 section 4 for resource 
allocation details.

2. On the UE Client PC, launch the Windows Command Prompt. Go to 
the directory where the IPERF program is installed, and then type the 
appropriate command for the data rate you want to test. For example: 
iperf -s -i1 -u -l10000 -w20m  sets up reception of 100Mbps.

3. On the Application Server PC, launch the Windows Command 
Prompt. Go to the directory where the IPERF program is installed, 
and then type the appropriate command for the data rate you want 
to test. For example, iperf -c {host IP address} -u -i1 –l2900 -t600 
–b102m -w20m for 102Mbps. The ”host IP address” required is that 
of the client UE, set in the Scenario File you loaded in section 4. 
Check the data rate shown in the command window..

4. You can use different combinations of scenario file and iperf com-
mand string to test other data rates that your device can support. 
Refer to 3GPP specifications 36.213 Tables 7.1.7.1-1 and 7.1.7.2.1-1 
and 36.306 Table 4.1-1 for details of appropriate settings.

NOTE: If the NACK rate is too high, the iperf server may stop. If this hap-
pens, check that the client is capable of receiving the specified rate and 
that the connection is working reliably.

 IPERF command explanations (type <iperf - h> for a complete list):

  - c sets the client mode, requires host IP address

  - s sets the server mode

  - u sets the mode to UDP

  - i sets the reporting interval in seconds

  - l sets the packet size in bytes 

  - t sets the time in seconds

  - b sets the data rate in Mbps

  - w sets the window size in MHz
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Uplink throughput test

5. On the PXT, set the BSE, MODE SETUP, MORE 2/2, Phy Settings, UL  
 Resource Allocation configuration to Resource Allocation Mode   
 Fixed MAC Padding, and set the I_MCS and RB Size to match your  
 application test requirements.

6. On the Application Server PC, launch the Windows Command   
 Prompt. Go to the directory where the IPERF program is installed,  
 and then type the following command: iperf -s -i1 -u -w20m

7. On the UE Client PC, launch the Windows Command Prompt. Go to  
 the directory where the IPERF program is installed, and then type the
 following command: iperf -c {host IP address} -u -i1 -l2900 -t600 - 
 b20m -w20m, where the “host IP address” required is that of the  
 application server PC (192.168.1.230).   

NOTE: In uplink mode, the PXT has an upper data throughput limit of 20Mbps.
 

Video streaming test

Before running this test, locate, download and install the freeware media 
server application “VLC” by VideoLAN on both the application server and 
client PCs.

On the Application Server PC:

1. Run the VLC application.
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2. In the main menu, select “Streaming” from the Media tab.

3. On the File tab, click the Add button to add a local video file to be streamed.
 

4. Click the Stream button and the following dialog box will be displayed.
 

5. Make sure the name and directory of the selected video file are correct. 
Click Next to proceed to next step.
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6. Open the “File” drop-down menu, select the “UDP” option and click Add.
 

7. Enter the IP address allocated to the UE (192.168.1.51). Set the port  
 number to 1234. Uncheck the “Active Transcoding” option.

8. Click Stream to begin streaming the video.

NOTE: To stream more than one video, repeat the above procedures and 
enter the next port setting (1235, 1236, and so forth).

On the UE Client PC:

9. Run the VLC Media Player. From the top menu, select “Open Network 

 Stream” from the Media tab. 
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10. Enter the following as the network URL: udp://@: followed by the port number  

 (1234)

11. Click Play to play the video stream. While the video is streaming, you can  

 adjust the channel capacity by changing the PHY settings on the PXT. 
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FTP throughput test

Before running this test, locate, download and install the freeware ftp 
application “FileZilla” on both the application server and client PCs.  
Install the Filezilla server application on the Application Server PC and 
the Filezilla client application on the UE client PC.

On the Application Server PC:

1. Start the FileZilla FTP Server Interface program.

NOTE: Filezilla Server runs as a service, and once installed, will remain 

running in the background. To manage the service, go to “Control Panel”, 

“Administrative Tools”and select “Services”. To prevent the service re-starting 

when Windows starts, right-click Filezilla Server, select “Properties” and change 

the “Startup Type” to “Manual”.

2. Create a new user account:

 a. From the top menu, select “Users” from the Edit tab.

 b. In the “General” section, click Add and create a new account with “test”  

  as both the account name and password.
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3. In the “Shared Folders” section, click Add and select the folder where the  

 test files are located. Check the “Read”, “Write”, “Delete” and “List” boxes  

 to allow bi-directional movement of files between the server and client PCs.

4. In the “Speed Limits” section, select the No Limit option for both Downlink  

 and Uplink Speed Limit, then click OK to save the settings. 

On the PXT:

Set the DL Resource Allocation to Auto, and I_MCS and RB Size to match 

the Scenario file (Inno 28/50), and UL Resource Allocation to Fixed MAC 

Padding and I_MCS and RB Size to match your application test requirements.
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On the UE Client PC:

5. Start the FileZilla FTP client application.

 

6. Select the Edit tab on the main menu, go to the “Transfers” section of the  

 “Settings” tab and change the Maximum simultaneous transfers to 10.

 

7. Select the File tab on the top menu, and go to “Site Manager”. 

8. In the General tab, click “New Site” and the server name (server), the IP

 address of the Application Server PC  (192.168.1.230), the logon type (normal)  

 and the userID and password (both “test”). 
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9. Click Connect to connect to the Application Server PC.

Once the connection is established, drag and drop files between the remote and 

local PCs and observe the transfer times. Change the PXT modulation type and 

resource block allocations to modify the available transmission bandwidth and 

observe the effects.



18

VoIP test

Before running this test, locate, download and install the Brekeke SIP 
server application and the freeware X-lite VoIP client on the application 
server PC, and the X-lite VoIP client on the UE Client PC. Note that you 
must arrange the purchase of a product ID for the SIP server application 
to continue to use the product after an initial evaluation period.

1. On the PXT, set the BSE, MODE SETUP, MORE 2/2, Phy Settings, 
UL Resource Allocation configuration to Resource Allocation Mode  
Fixed MAC Padding, and set the I_MCS and RB Size to match your 
application test requirements.

2. Run “Brekeke SIP Server Admintool” and enter your product ID and 
then click [I agree] button. If you do not have a product ID, click 
[Need a Product ID] to get an evaluation version product ID. Type 
“sa” for both the username and  password to login to the SIP Server.
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3. From the top menu, select the User Authentication tab, then select New  

 User, and then create two new user accounts, for example, “user1” with  

 display name “user1” and address “address1”, and “user2” with display  

 name “user2” and address “address2”. Select View Users and check that  

 the two user accounts are displayed.

4. Run the X-Lite application in the Application Server PC. From the top menu,  

 select “SIP Account Settings”, and enter the “user1” details from the SIP  

 server setup and the server PC IP address (192.168.1.230) for the Domain as  

 shown in the following figure. Select “Properties”, choose the “Topology”  

 tab, check the box “Manually specify range” and set the port numbers that  

 X-lite can use to 10230 and 10231 as shown.
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5. From the top menu, select “Options”, click on Advanced, select “Network”,  

 set the connection speed to LAN and click “Apply”.
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6. Run the X-Lite application in the UE Client PC. From the top menu, select  

 “SIP Account Settings”, and enter the “user2” details from the SIP server  

 setup and the Application Server PC IP address (192.168.1.230) for the  

 Domain as shown in the following figure. 

7. Select “Properties”, choose the “Topology” tab, check the box “Manually  

 specify range” and set the port numbers that X-lite can use to 10051 and  

 10052 as shown.

8. From the top menu, select “Options”, click on Advanced, select “Network”,  

 set the connection speed to LAN and click “Apply”.
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9. In the top menu of the SIP Server installed in the Application Server PC,  

 select the “Registered Clients” tab and “View Clients”to see the registered  

 clients list.

10. Make a VOIP call from “user1” (X-Lite in the Application Server PC) to  

 “user2” (X-Lite in the UE Client PC) by entering the contact details   

 (name@<PC IP address:portnumber>) in the softphone contacts area as  

 shown.

And add video . . .
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6.  Appendix – LTE structure

Multiple access technology

Downlink and uplink transmission in LTE are based on the use of multiple 

access technologies: specifically, orthogonal frequency division multiple access 

(OFDMA) for the downlink, and single-carrier frequency division multiple access 

(SC-FDMA) for the uplink.

Transmission bandwidth

In order to address the international wireless market and regional spectrum regu-

lations, LTE includes varying channel bandwidths selectable from 1.4 to 20 MHz, 

with sub-carrier spacing of 15 kHz. In the case of multimedia broadcast multicast 

service (MBMS), a sub-carrier spacing of 7.5 kHz is also possible. Sub-carrier 

spacing is constant regardless of channel bandwidth. To allow for operation in 

different sized spectrum allocation, the transmission bandwidth is instead altered 

by varying the number of OFDM sub-carriers as shown in Table 6-1.

Frame structure

There are two radio frame structures for LTE: frame structure type 1 (FS1) for 

full duplex and half duplex Frequency Division Duplex (FDD), and frame structure 

Type 2 (FS2) for Time Division Duplex (TDD). FS1 is optimized to co-exist with 

3.84Mbps UMTS systems. This structure consists of ten 1ms sub-frames, each 

composed of two 0.5ms slots, for a total duration of 10ms. The FS1 is the same 

in the uplink and downlink in terms of frame, sub-frame, and slot duration 

although the allocation of the physical signals and channels is quite different. 

Uplink and Downlink transmissions are separated in the frequency domain.

Resource block

The smallest time-frequency unit used for downlink transmission is called a 

resource element, defined as one symbol on one sub-carrier. A group of contigu-

ous sub-carriers and symbols form a resource block (RB). Data is allocated to 

each user in terms of RB. For a Type 1 frame structure using normal cyclic prefix 

(CP), a RB spans 12 consecutive sub-carriers at a sub-carrier spacing of 15kHz, 

and seven consecutive symbols over a slot duration of 0.5ms. Even though a RB 

is defined as 12 sub-carriers during one 0.5ms slot, scheduling is carried out on 

a sub-frame (1 ms) basis. Using normal cyclic prefix, the minimum allocation 

the base station uses for user equipment (UE) scheduling is 1 sub-frame (14 

symbols) by 12 sub-carriers. The size of a RB is the same for all bandwidths; 

therefore, the number of available physical RBs depends on the transmission 

bandwidth as shown. 
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Channel bandwidth 
[MHz] for LTE FDD

1.4 3 5 10 15 20

Number of resource 
blocks

6 15 25 50 75 100

Number of sub-carriers 72 180 300 600 900 1200

Physical signals and physical channels are summarized in the tables below. In 

the downlink, primary, and secondary synchronization signals encode the cell 

identification, allowing the UE to identify and synchronize with the network. 

In both the downlink and the uplink, there are reference signals (RSs), known 

as pilot signals in other standards, which are used by the receiver to estimate 

the amplitude and phase flatness of the received signal. Alongside the physical 

signals are physical channels, which carry the user and system information.  

Table 6.1 LTE transmission parameters



25

DL signals Full name Modulation sequence Purpose

P-SS Primary synchronization signal One of 3 Zadoff-Chu 

sequences

Used for cell search and identification by 

the UE; carries part of the cell ID (one of 3 

orthogonal sequences)

S-SS Secondary synchronization signal Two 31-bit BPSK M-sequence Used for cell search and identification by the 

UE; carries the remainder of the cell ID (one 

of 168 binary sequences)

RS Reference signal (pilot) Complex I+jQ pseudo random 

sequence (length-31 Gold

sequence) derived from cell ID

Used for DL channel estimation; exact 

sequence derived from cell ID, (one of 3 * 

168 = 504 pseudo random sequences)

UL signals Full name Modulation sequence Purpose

DM-RS Demodulation reference signal uth root Zadoff-Chu Used for synchronization to the UE and UL 

channel estimation

S-RS Sounding reference signal Based on Zadoff-Chu Used to monitor propagation conditions with UE

DL channels Full name Modulation format Purpose

PBCH Physical broadcast channel QPSK Carries cell-specific information

PDCCH Physical downlink control 

channel

QPSK Scheduling, ACK/NACK

PDSH Physical downlink shared 

channel

QPSK, 16QAM, 64QAM Payload

PMCH Physical multicast channel QPSK, 16QAM, 64QAM Payload for multimedia broadcast multicast 

service (MBMS)

PCFICH Physical control format indicator 

channel

QPSK Carries information about the number of 

PDCCH OFDMA symbols per 

sub-frame (1, 2, or 3)

PHICH Physical hybrid ARQ indicator 

channel

BPSK with I 

& Q CDM

Carries the hybrid-ARQ ACK/NAK

UL channels Full name Modulation format Purpose

PRACH Physical random access channel uth root Zadoff-Chu Call setup

PUCCH Physical uplink control channel On/Off Keying BPSK,QPSK Scheduling, ACK/NACK

PUSCH Physical uplink shared channel QPSK, 16 QAM, 64 QAM Payload

Table 6.2 LTE Uplink and Downlink Signals and Channels 
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7.  Calling Agilent Technologies
Agilent Technologies has offices around the world to provide you with complete 

support for your wireless test set. To obtain servicing information or to order 

replacement parts, contact the nearest Agilent Technologies office listed below. 

In any correspondence or telephone conversations, refer to your test set by its 

product number, full serial number, and software revision.

Press the INFO front panel key to view the product number (E6621A), serial 

number, and software revision information. A serial number label is also 

attached to the rear panel of the test set. 

Locations for Agilent Technologies

For online assistance, go to: http://www.agilent.com/find/assist

Software and Technical Support Contracts

If you have a Software and Technical Support Contract you can contact Agilent 

at the appropriate email address:

• wireless_test_support_americas@agilent.com

• wireless_test_support_japan@agilent.com

• wireless_test_support_europe@agilent.com      

• wireless_test_support_asia@agilent.com

• wireless_test_support_korea@agilent.com 

Where to Find the Latest Information

Agilent will periodically update product documentation. For the latest informa-

tion about the E6621A PXT Wireless Communications Test Set, including

software upgrades, operating and application information, and product and

accessory information, see the following URL: http://www.agilent.com/find/pxt

Is your product software up-to-date?

Agilent will periodically release software updates to fix known defects and

incorporate product enhancements. To search for software updates for your

product,log on with your credentials to the Agilent Technical Support website at

http://www.agilent.com/find/softwaremanager
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